FR 3 059 998 - B1

REPUBLIQUE FRANCAISE (1) N° de publication : 3 059 998

- (a n’utiliser que pour les

INSTITUT NATIONAL commandes de reproduction)
DE LA PROPRIETE INDUSTRIELLE @ N° d’enregistrement national : 16 62456
COURBEVOIE
@ Int CI® : C 04 B 35/66 (2017.01),C 03B 5/43, C 04 B 35/48,
C 04 B 35/64
@) BREVET D'INVENTION B1
. BETON FRITTE A BASE DE ZIRCON.
@ Date de dépét : 14.12.16. Références a d’autres documents nationaux
apparentés :

Priorité :

O Demande(s) d’extension :

@ Demandeur(s) : SAINT-GOBAIN CENTRE DE
RECHERCHES ET D'ETUDES EUROPEEN Société
par actions simplifiée — FR.

Date de mise a la disposition du public
de la demande : 15.06.18 Bulletin 18/24. @ Inventeur(s) : CHAMPION THIBAULT et BOBO
MICHEL.

Date de la mise a disposition du public du
brevet d'invention : 15.07.22 Bulletin 22/28.

Liste des documents cités dans le rapport de

recherche : @ Titulaire(s) : SAINT-GOBAIN CENTRE DE

RECHERCHES ET D'ETUDES EUROPEEN Société
par actions simplifiée.

Se reporter a la fin du présent fascicule

Mandataire(s) : CABINET NONY.




10

15

20

25

30

Béton fritté a base de zircon

Domaine technique

L'invention concerne un béton fritté a base de zircon destiné a étre en contact avec du
verre en fusion.
L’invention concerne également un procédé de fabrication d’'un tel béton et des

applications spécifiques d’un tel béton.

Etat de la technique

Parmi les produits frittés, les bétons frittés a base de zircon, c'est-a-dire comportant plus
de 70% en masse de zircon (silicate de zirconium : ZrO,.SiO;, ou ZrSiO,), conviennent

trés bien a une utilisation au contact de verres en fusion borosilicate et opale.

La fabrication des bétons frittés doit cependant répondre a des contraintes de mise en
ceuvre. En particulier la rhéologie du béton frais et son temps de prise doivent étre

adaptés pour qu'il puisse étre mis en place au moyen de vibrations.

Par ailleurs, la formation de bulles a été observée lorsque ces bétons sont en contact
avec du verre en fusion, comme décrit dans « Electrochemical mechanism of the oxygen
bubble formation at the interface between oxidic melts and zirconium silicate
refractories », Baucke et Al., Glastech. Ber.61 (1988) Nr. 5, 109-118. Ces bulles sont

ensuite piégées dans le verre, donnant lieu a des défauts rédhibitoires.

Il existe donc un besoin pour un béton fritté induisant un phénoméne de bullage réduit
lorsqu’il est en contact avec un verre en fusion, notamment avec un verre borosilicate ou

opale en fusion, et qui, a I'état frais, puisse étre mis en place par vibrations.

La présente invention vise a satisfaire ce besoin.

Résumé de I’'invention

Plus particuliérement, l'invention concerne un béton fritté ayant la composition chimique
moyenne suivante, en pourcentages en masse sur la base des oxydes et pour un total de
100% :

ZrO, : 55 a 70%,

SiO- : 25 a 40%,

Ca0: 0,2 a 3,0%,

AlO5 : 0,5 a7,0%,
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MgO : 0,1 a 3,0%,
P20s: 0,3 a2 9,0%,
autres oxydes : < 5,0%,
et présentant plus de 70% de zircon, en pourcentage massique sur la base de la masse

des phases cristallisées.

De maniére surprenante, comme on le verra plus en détail dans la suite de la description,
les inventeurs ont constaté que la composition et la microstructure d’un béton fritté selon
linvention conduisent a une réduction considérable du bullage, sans modifier

substantiellement les conditions de fabrication.

Un béton fritté selon [linvention peut encore comporter une ou plusieurs des

caractéristiques optionnelles et préférées suivantes :

- la teneur en ZrO, est supérieure a 57%, de préférence supérieure a 58%, de
préférence supérieure a 59%, de préférence supérieure a 61%, et/ou inférieure a 67%,
de préférence inférieure a 65%, de préférence inférieure a 64,5% ;

- la teneur en SiO» est supérieure a 26%, de préférence supérieure a 27%, de
préférence supérieure a 28%, de préférence supérieure a 29%, et/ou inférieure a 37%,
de préférence inférieure a 35%, de préférence inférieure a 33%, de préférence
inférieure a 31% ;

- la teneur en CaO est supérieure a 0,3%, de préférence supérieure a 0,4%, de
préférence supérieure a 0,5%, et/ou inférieure a 2,5%, de préférence inférieure a 2,0%,
de préférence inférieure a 1,5%, de préférence inférieure a 1,2% ;

- la teneur en AlQO; est supérieure a 0,8%, de préférence supérieure a 1,0%, de
préférence supérieure a 1,5%, et/ou inférieure a 6,5%, de préférence inférieure a 6,0%,
de préférence inférieure a 5,5%, de préférence inférieure a 5,0%, de préférence
inférieure a 4,5%, de préférence inférieure a 4,0% ;

- la teneur en MgO est supérieure a 0,3%, de préférence supérieure a 0,4%, et/ou
inférieure a 2,8%, de préférence inférieure a 2,6%, de préférence inférieure a 2,4%, de
préférence inférieure a 2,2%, de préférence inférieure a 2,1%, de préférence inférieure
a 1,7%, de préférence inférieure a 1,3%, de préférence inférieure a2 0,9% ;

- la teneur en P.0Os est supérieure a 0,4%, de préférence supérieure a 0,5%, de
préférence supérieure a 0,7%, de préférence supérieure a 0,9%, de préférence
supérieure a 1,2%, et/ou inférieure a 8,5%, de préférence inférieure a 8%, de
préférence inférieure a 7,5%, de préférence inférieure a 7,0%, de préférence inférieure
a 6,5%, de préférence inférieure a 5,5%, de préférence inférieure a 5,0%, de

préférence inférieure a 4,0%, de préférence inférieure a 3,0% ;
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- la teneur en « autres oxydes » est inférieure a 4,5%, de préférence inférieure a 4,0%,
de préférence inférieure a 3,5%, de préférence inférieure a 3,0%, de préférence
inférieure a 2,5%, de préférence inférieure a 2%, de préférence inférieure a 1,5% ;

- de préférence,

- la teneur en Na;O est inférieure a 0,7%, de préférence inférieure a 0,5%, de
préférence inférieure a 0,3%, de préférence inférieure a 0,1%, et/ou

- la teneur en Fe;O; est inférieure a 1%, de préférence inférieure a 0,7%, de
préférence inférieure a 0,5%, de préférence inférieure a 0,3%, de préférence
inférieure a 0,15% ;

- la teneur en zircon, en masse sur la base des phases cristallisées est supérieure a
75%, de préférence supérieure a 80%, de préférence supérieure a 85%, voire
supérieure a 90%, voire supérieure a 95% ;

- la zircone libre est 'une des autres phases cristallisées ;

- dans un mode de réalisation, les phases cristallisées sont, pour plus de 95%, de
préférence plus de 98%, de préférence sensiblement 100% en masse, le zircon et la
zircone libre ;

- la masse volumique apparente du béton fritté est supérieure a 3,30 g/cm?®, de
préférence supérieure a 3,40 g/cm®, de préférence supérieure a 3,50 g/cm?®, de
préférence supérieure a 3,60 g/cm?®, et/ou inférieure a 3,90 g/cm?® de préférence
inférieure a 3,80 g/cm?®, de préférence inférieure a 3,70 g/cm?® ;

- la porosité ouverte du béton fritté est supérieure a 10%, de préférence supérieure a
15%, et/ou inférieure a 25%, de préférence inférieure a 20% ;

- le béton fritté présente la forme d'un bloc dont toutes les dimensions sont supérieures
a1 mm, supérieures a 5 mm, supérieures a 5 cm et dont toutes les dimensions sont de
préférence inférieures a 150 cm ; Il présente de préférence une masse supérieure a

1 kg, supérieure a 5 kg, supérieure a 10 kg, voire supérieure a 100 kg.

L’invention concerne aussi un procédé de fabrication d’'un béton fritté selon I'invention,
comprenant les étapes successives suivantes :
a) mélange de matiéres premiéres particulaires pour former une charge de
départ,
b) activation de ladite charge de départ de maniére a obtenir un béton frais,
C) mise en forme dudit béton frais,
d)  durcissement dudit béton frais de maniére a obtenir un béton durci,

e) frittage dudit béton durci de maniére a obtenir ledit béton fritté,
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la composition de la charge de départ étant adaptée de maniére que le béton fritté obtenu

aprés I'étape e) soit conforme a I'invention.

L’adaptation de la charge de départ ne pose aucune difficulté 8 'homme du métier.
De préférence, la charge de départ comporte
entre 1,0% et 6,0% en poids d’un liant hydraulique, de préférence d’'un ciment, et
plus de 0,25% d’un phosphate de magnésium, ledit phosphate de magnésium

apportant plus de 50% du phosphore de la charge de départ.

De maniére surprenante, les inventeurs ont constaté cette combinaison de liant
hydraulique et de phosphate de magnésium améliore sensiblement les possibilités de

mettre en forme le béton frais, notamment sous vibrations.

De préférence, le procédé selon linvention présente encore une ou plusieurs des

caractéristiques optionnelles suivantes :

- dans la charge de départ, la quantité massique de particules de zircon, c'est-a-dire de
particules comportant plus de 90%, de préférence plus de 95% en masse de zircon sur
la base de la masse des phases cristallisées desdites particules, est supérieure a 70%,
de préférence supérieure a 73%, de préférence supérieure a 75%, de préférence
supérieure a 78%, de préférence supérieure a 80%, et/ou inférieure ou égale a 95%,
de préférence inférieure ou égale a 90% de la masse de la charge de départ ;

- dans la charge de départ, la quantité massique de particules de zircone libre, c'est-a-
dire de particules comportant plus de 90%, de préférence plus de 95% en masse de
zircone non associée a de la silice dans une phase de zircon, sur la base de la masse
des phases cristallisées desdites particules, est supérieure a 1,0%, de préférence
supérieure a 3,0%, de préférence supérieure a 5,0%, de préférence supérieure a 6,0%,
et/ou inférieure a 20,0%, de préférence inférieure a 15,0%, de préférence inférieure a
12,0% ;

- la quantité de liant hydraulique dans la charge de départ est supérieure a 1,5%, de
préférence supérieure a 2,0%, et/ou inférieure a 5,5%, de préférence inférieure a 5,0%,
de préférence inférieure a 4,0% de la masse de la charge de départ ;

- le liant hydraulique est un ciment, de préférence un ciment alumineux, de préférence
un ciment d’aluminate(s) de calcium ;

- la teneur en alumine du liant hydraulique est de préférence comprise entre 50% et
85% ;

- la charge de départ est constituée, pour plus de 90%, de préférence pour plus de 92%,

de préférence pour plus de 95%, de préférence pour plus de 97%, de préférence pour
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plus de 98% de sa masse, de particules de zircon, de particules de liant hydraulique,
de particules de de phosphate de magnésium, de particules de fumée de silice, de
particules de zircone et de particules d’additif de mise en forme ;

la charge de départ comporte du phosphate de magnésium Mg(POs): ;

la quantité massique de phosphate de magnésium dans la charge de départ est
supérieure a 0,3%, de préférence supérieure a 0,5%, de préférence supérieure a 1,0%,
voire supérieure a 1,5%, et/ou inférieure a 14,0%, de préférence inférieure a 13,0%, de
préférence inférieure a 12,0%, de préférence inférieure a 11,0%, de préférence
inférieure a 10,0%, de préférence inférieure a 9,0%, de préférence inférieure a 8,0%,
de préférence inférieure a 7,0%, de préférence inférieure a 6,0%, de préférence
inférieure a 5,0%, de préférence inférieure a 4,0%. Avantageusement, le
comportement au fluage a hautes températures en est amélioré ;

Dans un mode de réalisation préféré, le seul phosphate présent dans la charge de
départ est Mg(PO:s): et la quantité massique de Mg(PQOs). dans la charge de départ est
supérieure a 0,3%, de préférence supérieure a 0,5%, de préférence supérieure a 1,0%,
voire supérieure a 1,5%, et/ou inférieure a 14,0%, de préférence inférieure a 13,0%, de
préférence inférieure a 12,0%, de préférence inférieure a 11,0%, de préférence
inférieure a 10,0%, de préférence inférieure a 9,0%, de préférence inférieure a 8,0%,
de préférence inférieure a 7,0%, de préférence inférieure a 6,0%, de préférence
inférieure a 5,0%, de préférence inférieure a 4,0% ;

Dans un mode de réalisation préfére, le percentile 99,5, Dgos de la charge de départ
est inférieur a 15 mm, de préférence inférieure a 10 mm, de préférence inférieur a 8
mm, de préférence inférieur 8 5 mm, voire inférieur & 4mm, voire inférieure 8 3 mm et
de préférence supérieur a 0,4 mm, de préférence supérieure @ 1 mm, voire supérieur a

2 mm.

L’invention concerne enfin une unité de production de verre, en particulier un four de

verrerie, comportant une piéce comportant ou constitué en un béton fritté selon

linvention, de préférence fabriqué selon le procédé selon I'invention.

En particulier et sans que cela ne limite I'invention, ladite piéce peut étre :

une brique a nez,

une dalle de sole,

une piéce de superstructure,

un bloc canal d’'un canal d’alimentation,

un bloc brileur,
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- un consommable, par exemple une chemise, un plongeur, un agitateur, un rotor, une
rondelle d’écoulement, une cuvette d’avant-corps,
- un mandrin utilisé dans une fabrication de tubes en verre selon le procédé Danner,

- un bloc porte-électrode.

Définitions

- Par « charge de départ » ou « béton non fagonné », on entend un mélange particulaire
comportant un liant hydraulique apte a prendre en masse aprés activation.

- L’activation est un processus de prise en masse. L’état activé résulte classiquement
d’'une humidification d’'un béton non fagonné avec de I'eau ou un autre liquide. Pendant
ce processus, un béton non fagonné humide est appelé « béton frais ».

- La masse solide obtenue par la prise en masse d'un béton frais est appelée
« béton durci ». Un béton durci est classiquement constitué d'un ensemble de grains
grossiers présentant une taille comprise entre 150 um et 25 mm liées par une matrice,
ladite matrice assurant une structure continue entre les grains grossiers, obtenue,
aprés activation, lors de la prise en masse de la charge de départ. Aprés frittage, le
béton durci est appelé « béton fritté ».

- Par «liant hydraulique », on entend un liant qui, lors de I'activation, génére une prise et
un durcissement hydraulique, généralement a température ambiante. Un ciment est un
liant hydraulique. Un ciment alumineux est un exemple de ciment. Un ciment
d’aluminate(s) de calcium est un exemple de ciment alumineux.

- La « taille » des particules est évaluée classiquement par une caractérisation de
distribution granulométrique réalisée avec un granulométre laser pour la fraction des
particules passant a travers un tamis a mailles carrées d’ouverture égale a 150 um et,
pour le refus audit tamis, par tamisage a laide de tamis a mailles carrées. Le
granulometre laser peut étre, par exemple, un Partica LA-950 de la société HORIBA.

- Les percentiles ou « centiles » 50 (Dso) et 99,5 (Dgos) sont les tailles de particules
d’'une poudre correspondant aux pourcentages en masse de 50 % et de 99,5 %
respectivement, sur la courbe de distribution granulométrique cumulée des tailles des
particules de la poudre, les tailles des particules étant classées par ordre croissant. Par
exemple, 99,5%, en masse des particules de la poudre ont une taille inférieure a Dgg 5
et 50% des particules en masse ont une taille supérieure ou égale a Ds. Les
percentiles peuvent étre déterminés a l'aide d’une distribution granulométrique réalisée
alaide d’'un granulométre laser et/ou de tamisages.

- On appelle « taille médiane » le percentile 50 (Dso).
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- On appelle « taille maximale » le percentile 99,5 (Dgg 5).

- On appelle « phosphate de magnésium » un composé choisi parmi Mg(H2PQOs)2,
MgHPO4, Mgs(POs4)2, Mg(PO3)2, Mg2P-0O7 et leurs mélanges, lesdits composés pouvant
éventuellement incorporer des molécules d’eau, comme par exemple Mg3s(PO4)2.nH>0
avecn = 0.

- Lorsqu'il est fait référence a ZrO-, il y a lieu de comprendre ZrO; et les traces de HfO,.
Les traces de HfO, sont typiquement inférieures a 2% de la masse de I'ensemble ZrO-
+ HfO,. Ces traces toujours naturellement présentes dans les sources de zircone libre

ou de zircon. L'oxyde d’hafnium n’est donc pas considéré comme un « autre oxyde ».

Tous les pourcentages de la présente description sont des pourcentages en masse, sauf
mention contraire. Les pourcentages relatifs a la composition sont sur la base des oxydes,
sauf indication contraire.

La somme des teneurs des constituants d’'un béton fritté selon I'invention est de 100%.
Les teneurs ne peuvent donc prendre des valeurs dans les plages revendiquées que dans
la mesure ou cette contrainte est respectée. Par exemple, toutes les limites supérieures
ou inférieures des plages des constituants d’un béton fritté selon l'invention ne peuvent
étre atteintes simultanément.

Les verbes « comporter », « présenter » ou « comprendre » doivent étre interprétés de
maniére large, non limitative, sauf indication contraire. Par exemple, si « la charge de
départ comporte du phosphate de magnésium Mg(POs). », cela n’exclut pas la présence

d’'un autre phosphate de magnésium.

Bréve description des figures

D’autres caractéristiques et avantages de l'invention apparaitront encore a la lecture de la
description détaillée qui va suivre et a 'examen du dessin détaillé dans lequel les figures
1 et 2 représentent des photographies des surfaces de verre observées des exemples 1,
hors invention, et 3, selon linvention, respectivement.

Les photographies ont été réalisées avec le méme grossissement.

Description détaillée

Des étapes similaires a celles d’'un procédé conventionnel de fabrication d’un béton fritté
destiné a des applications dans des fours de fusion de verre peuvent étre mises en

csuvre.
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En particulier, un béton selon linvention peut étre fabriqué suivant les étapes a) a ¢)

décrites ci-dessus.

A I'étape a), une charge de départ particulaire séche est préparée en fonction de la

composition et de la porosité souhaitées.

Composition
La fagon de déterminer les proportions des constituants de la charge de départ est

parfaitement connue de ’homme du métier. En particulier, rThomme du métier sait que le
zirconium, le silicium, le calcium, 'aluminium, le magnésium et le phosphore présents
dans la charge de départ se retrouvent dans le béton fritté. Il sait également déterminer
guels constituants vont se transformer pour constituer la matrice.

La charge de départ comporte de préférence plus de 0,25%, de préférence plus 0,5%, de
préférence plus de 1% d'un phosphate de magnésium, de préférence sous forme de
Mg(PQOs)., ledit phosphate de magnésium apportant plus de 50%, de préférence plus de
60%, de préférence plus de 70%, de préférence plus de 80%, du phosphore de la charge
de départ. De maniére surprenante, et comme démontré par les exemples ci-dessous, les
inventeurs ont découvert que l'association de magnésium au phosphore sous la forme
d’'un phosphate de magnésium améliore sensiblement les possibilités de mettre en forme
le béton frais, notamment sous vibrations, tout en limitant le bullage du béton fritté lorsqu’il
est en contact avec du verre en fusion.

De préférence, la charge de départ est constituée de particules de zircon, de liant
hydraulique, de préférence d’'un ciment, de phosphate de magnésium, de fumée de silice,
de zircone et d’additif de mise en forme.

De préférence, plus de 70%, plus de 80% du zirconium, exprimé sous la forme de zircone
ZrO,, en pourcentage massique, est apporté sous forme de zircon, le reste étant apporté
sous forme de zircone libre.

De préférence, la charge de départ comporte au plus 5% de silice libre, c'est-a-dire non
associée, comme par exemple dans du zircon. De préférence, la silice libre est de la
fumée de silice. De préférence, la fumée de silice contient plus de 93% de silice (SiOy), la
poudre de fumée de silice présentant une taille médiane comprise entre 0,1 et 0,8 um, de
préférence entre 0,2 et 0,7 um.

Le liant hydraulique est un ciment, de préférence un ciment alumineux, de préférence un
ciment d’aluminate(s) de calcium.

De préférence, plus de 60%, plus de 65%, plus de 70% de I'aluminium, exprimé sous la

forme d’alumine AlOs, en pourcentage massique, est apporté sous forme d'un liant
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hydraulique, de préférence sous la forme d’'un ciment alumineux, de préférence sous la
forme d’'un ciment d’aluminate(s) de calcium.
Les « autres oxydes » sont les oxydes autres que ZrO,, SiO,, Ca0, Al.O3, MgO et P20s.
Dans un mode de réalisation préféré, les « autres oxydes » sont des impuretés, c’est-a-
dire des constituants inévitables, introduits nécessairement avec les matiéres premiéres.
A titre d’'exemples, on peut citer Na,O et Fe;0s.
De préférence,
- la teneur en NaxO est inférieure a 0,7%, de préférence inférieure a 0,5%, de
préférence inférieure a 0,3%, de préférence inférieure a 0,1%, et/ou
- la teneur en Fe;O; est inférieure a 1%, de préférence inférieure a 0,7%, de
préférence inférieure a 0,5%, de préférence inférieure a 0,3%, de préférence
inférieure a 0,15%.
La charge de départ contient de préférence un additif de mise en forme, de préférence
temporaire (c'est-a-dire éliminé lors du frittage), de préférence en une quantité massique
inférieure a 3,0%, de préférence inférieure a 2,0%, de préférence inférieure a 1,0%, de
préférence inférieure a 0,5% et de préférence supérieure a 0,05%, de préférence
supérieure a 0,1%.
De préférence, I'additif de mise en forme est choisi parmi
les plastifiants, comme le polyéthyléne glycol (PEG) ou l'alcool polyvinylique (APV),
les liants temporaires organiques tels que les résines, les lignosulfonates, la dextrine,
les alginates,
les défloculants, tels que les polyphosphates de métaux alcalins, les polyacrylates de
métaux alcalins, les polycarboxylates, et
les mélanges de ces produits.
Dans un mode de réalisation, la charge de départ comporte des fibres, de préférence
organiques, de préférence du type vinylique ou polypropyléne, de préférence en une
quantité massique comprise entre 0,01% et 0,1%, de préférence en une quantité
massique comprise entre 0,01% et 0,03%. De préférence la longueur moyenne (moyenne
arithmétique) de ces fibres est supérieure 4 6 mm, de préférence comprise entre 18 et 24
mm. Ces fibres facilitent avantageusement I'évacuation de I'eau pendant le séchage.

Dans un autre mode de réalisation, la charge de départ ne comporte pas de fibres.

Distribution granulométrique

De préférence, la taille maximale des particules de la charge de départ est inférieure ou
€gale a 15 mm, de préférence inférieure ou égale a 10 mm, de préférence inférieure ou

€gale a 8 mm, de préférence inférieure ou égale a 5 mm, voire inférieur 8 4 mm, voire
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inférieure a 3 mm et de préférence supérieur a 0,4 mm, de préférence supérieure 4 1 mm,
voire supérieur a 2 mm.

De préférence, plus de 30%, plus de 35%, voire plus de 45% des particules de zircon sont
des particules de granulat, c'est-a-dire présentant une taille comprise entre 150 um et 15
mm.

De préférence, plus de 45%, plus de 50% et moins de 70%, moins de 65% des particules
de zircon sont des particules fines, c'est-a-dire présentant une taille inférieure a 150 um.
De préférence, plus de 90%, plus de 95%, voire 100% des particules comportant plus de
15% en masse de CaO et/ou des particules comportant plus de 40% en masse de
AlO3 et/ou des particules comportant plus de 15% en masse de MgO et/ou des particules
comportant plus de 50% en masse de P-Os sont des particules fines, c'est-a-dire
présentant une taille inférieure a 150 um.

De préférence, la poudre des particules de zircone (apportant la zircone libre) présente
une taille médiane inférieure a 10 pm, de préférence inférieure a 8 um, de préférence
inférieure a 5 um, et/ou supérieure a 1 um, de préférence supérieure a 2 pm.

Les modéles de compaction d’Andréasen ou de Fuller-Bolomey peuvent étre utilisés pour
adapter la distribution granulométrique de la charge de départ a la porosité souhaitée. De
tels modéles de compaction sont notamment décrits dans l'ouvrage intitulé « Traité de
céramiques et maténiaux minéraux », C.A. Jouenne, Editions Septima. Paris (1984),
pages 403 a 405.

A l'étape b), de préférence aprés avoir malaxé a sec suffisamment pour obtenir un
mélange homogéne, de l'eau est classiquement ajoutée a la charge de départ. De
préférence, on ajoute au moins 3 % et moins de 8 %, de préférence moins de 7 % d’eau,
en pourcentages en masse par rapport a la masse minérale de la charge de départ,
hormis l'eau. La quantité d'eau est fonction de la technologie utilisée a I'étape c). Par
exemple pour une étape c¢) réalisée a l'aide d’'un coulage sous vibrations, un ajout d'une
quantité d'eau comprise entre 3% et 6%, en pourcentage massique sur la base de la
charge de départ, est préféré.

L’'eau est de préférence ajoutée progressivement dans le malaxeur en fonctionnement
jusqu’a obtention d’'un mélange humide sensiblement homogéne. L’ajout d’eau provoque

I'activation de la charge de départ, c’est-a-dire engage son processus de prise en masse.

A I'étape c), le béton frais obtenu a I'étape b) peut étre versé dans un moule, afin d'étre

mis en forme, de maniére a former une piéce crue.
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De préférence, le moule est conformé de maniére que le béton fritté obtenu se présente
sous la forme d’un bloc présentant une masse supérieure a 5 kg, de préférence a 10 kg.
De tels blocs sont bien adaptés aux applications visées.

La mise en forme peut résulter d’'un coulage, d'un vibro-coulage, d’un vibro-compactage,
d’'un pressage ou d’'une combinaison de ces techniques, de préférence d’'un coulage, d’'un

vibro-coulage ou d’'une combinaison de ces techniques.

A I’étape d), le béton frais prend en masse de maniére a obtenir un béton durci. Le béton
durci peut subir une étape de séchage, afin d’éliminer une partie de l'eau ayant été
utilisée pour la mise en forme. Une telle étape est parfaitement connue de 'lhomme du

métier.

A I'étape e), le béton durci est fritté a une température de préférence comprise entre
900°C et 1600°C, de préférence entre 1300°C et 1600°C, de préférence sous air, de
préférence a pression atmosphérique. La durée de frittage est adaptée en fonction des
dimensions du béton durci a fritter. La durée du palier de frittage est généralement
comprise entre 1 et 20 heures, de préférence entre 5 a 10 heures. Dans les applications
ou, dans sa position de service, le béton durci peut étre soumis a des conditions de
chauffage susceptibles de le fritter, le béton durci est de préférence mis en position sans
avoir été fritté, puis fritté in situ.

A lissue de I'étape e), on obtient un béton fritté selon I'invention.

De préférence, les oxydes représentent plus de 98,5%, plus de 99%, voire sensiblement

100% de la masse d’'un béton fritté selon I'invention.

Exemples

Les exemples non limitatifs suivants sont donnés dans le but d’illustrer I'invention.

Dans ces exemples, les matiéres premiéres employées suivantes ont été choisies, les

pourcentages donnés étant des pourcentages massiques :

- un granulat de zircon présentant l'analyse chimique suivante, en pourcentages
massiques : ZrQO; : 66%, SiO:z : 33%, ALO; : 0,3%, P.0s : 0,3%, Fex0s: < 0,1%,
TiO2 : < 0,1%, moins de 0,2 % d’autres composés, une taille comprise entre 0,5 et
2 mm et une taille médiane (Dso) égale a 0,9 mm,

- un granulat de zircon présentant l'analyse chimique moyenne suivante, en
pourcentages massiques: ZrO; : 66%, SiO. : 33%, ALO; : 0,3%, P2Os : 0,3%,
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Fe;0s3: <0,1%, TiO2: < 0,1%, moins de 0,2 % d’autres composés, une taille comprise
entre 0 et 0,5 mm, et une taille médiane (Dso) égale a 0,35 mm,

- un sable de zircon présentant I'analyse chimique moyenne suivante en pourcentages
massiques : ZrO; : 66,8%, SiO: : 32,9%, Al,Os : 0,52%, P»0s : 0,08%, Fex0Os : <0,1%,
TiO2 < 0,1%, moins de 0,2 % d'autres composés et une taille médiane (Dso) €gale a
170 pm,

- une farine de zircon présentant I'analyse chimique moyenne suivante, en pourcentages
massiques : ZrO; : 66,4%, SiO, : 32,7%, Al,O3 : 0,16%, P20s : 0,12%, Fex0Os : < 0,1%,
TiO2 : 0,10%, et moins de 0,2 % d’autres composés, et une taille médiane (Dso) €gale a
10,9 um,

- une poudre de zircon micronisé présentant 'analyse chimique moyenne suivante, en
pourcentages massiques : ZrO.: 63,6%, SiO; : 34,1%, AlLO; : 0,94%, P.0Os : 0,13%,
Fe,Os : 0,06%, TiO2 : 0,10%, et moins de 0,2 % dautres composés, et une taille
médiane (Dso) égale a 1,4 um,

- de la zircone, commercialisée par la Société Européenne des Produits Réfractaires
sous le nom de CC10 dont la taille médiane est égale a 3,5 ym, et présentant une
teneur massique en zircone supérieure a 98,5%,

- delafumée de silice dont la taille médiane est égale a 0,5 um et présentant une teneur
en silice supérieure a 93,5%,

- une poudre de phosphate de magnésium Mg(PQOzs),, présentant une taille médiane
égale 14 pym,

- un ciment d’aluminate(s) de calcium CA25R commercialisé par la société Almatis,
présentant une taille médiane (Dso) égale a 9 um,

- une poudre de polyphosphate de sodium,

- un ester de polycarboxylate modifié.

Des blocs de béton fritté ont été fabriqués selon un procédé conforme a I'invention.

A létape a), les matiéres premiéres ont été dosées et mélangées de maniére a former
une charge de départ.

A I'étape b), la charge de départ a été placée dans un malaxeur et une quantité d’eau telle
que décrite dans le tableau 1 a été ajoutée. Aprés un malaxage d'une durée de 10
minutes, le béton frais est obtenu.

A I'étape ¢), le béton frais est coulé sous vibrations (50 Hz, 0,3 mm de double amplitude)
dans un moule en bois.

A I'étape d), aprés la prise, un béton durci est obtenu, et démoulé.
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A I'étape e), le béton durci est fritté dans le cycle thermique suivant :

- montée de la température ambiante jusqu’a 1560°C a une vitesse de 100°C/h,

- maintien a 1560°C pendant 6 heures,

- descente en température a une vitesse €gale a 100°C/h jusqu’a 500°C, puis descente
libre jusqu’a la température ambiante.

Le tableau 1 suivant résume pour chaque exemple, la composition de la charge de

départ, la quantité d’eau utilisée a I'étape b) et la possibilité de mettre le béton en place

par vibrations.

Exemple | Exemple | Exemple | Exemple
1 2 3 4

Granulat de zircon 0,5-2 mm (%) 28,85 29,15 29,05 28,65
Granulat de zircon 0-0,5 mm (%) 10 9,8 9,7 9,6
Sable de Zircon (%) 24 23,3 23,3 23,1
Farine de zircon(%) 14 13,7 13,6 13,5
Zircon Micronisé (%) 7 6,8 6,8 6,7
Zircone (%) 10 9,8 9,7 9,6
Fumée de silice (%) 3 2,9 2,9 2,9
Ciment CA25R (%) 3 29 29 29
Mg(POs)2 (%) - - 1,9 2,9
Polyphosphate de sodium (%) - 1,5 - -
Ether de polycarboxylate modifié (%) 0,15 0,15 0,15 0,15
Eau (%) 3,7 4.1 4.1 4,3
Possibilité de mise en place du béton : . .

) i oui non oui oui
frais par vibrations

Tableau 1

Le tableau 1 montre que la présence de Mg(POs). en des quantités égales a 1,9 % et
2,9% modifie peu le comportement du béton frais qui reste coulable sous vibrations. Au

contraire, 'ajout de polyphosphate de sodium ne permet pas le coulage sous vibrations.

La masse volumique apparente et la porosité ouverte des bétons frittés des exemples 1, 3
et 4 ont été mesurées suivant la norme ISO5017.

Les analyses chimiques ont été réalisées par fluorescence X.

Le comportement au bullage au contact du verre en fusion des bétons frittés des
exemples 1, 3 et 4 a été évalué par la méthode suivante :

Des creusets présentant un diamétre extérieur égal 4 50 mm, une hauteur totale égale a
40 mm, un trou concentrique au diamétre extérieur présentant un diamétre égal 4 30 mm
et un fond d’épaisseur égale a 10 mm sont usinés dans les bétons frittés des exemples a
tester.

Chaque creuset est rempli par 30 grammes d’'une poudre de verre borosilicate clair dont

la taille médiane est égale a 1 mm, dont la taille maximale est égale a 2 mm, et
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présentant 'analyse chimique massique suivante : SiOz : 73%, BOs: 10%, AlLOs : 5%,
Na,O+K;0 : 7,5%, autres oxydes : 4,5%.
L’ensemble du creuset et du verre est ensuite placé dans un four électrique et subit le
traitement thermique suivant, sous air :

- montée a 1180°C a une vitesse égale a 500°C/h,

- maintien a 1180°C pendant 72 heures,

- descente a 785°C a une vitesse égale a 500°C/h,

- descente a 640°C a une vitesse égale a 20°C/h

- maintien a 640°C pendant 5 heures,

- descente a température ambiante a une vitesse égale a 8°C/h.

Le rapport de la surface des bulles générées lors du test et de la surface de verre
observée prise en compte, peut étre évalué avec la méthode suivante, non limitative.
Aprés refroidissement, de la résine est coulée dans le creuset de maniére a remplir
totalement le creuset. Le creuset est ensuite découpé de maniére a obtenir une tranche
d’épaisseur égale a 7 mm, ladite tranche contenant 'axe de symétrie vertical du creuset
et présentant une hauteur égale a celle du creuset.
La tranche est ensuite polie afin de rendre le verre transparent et faciliter les
observations, ledit polissage s’effectuant au minimum avec un papier grade 1200, de
préférence avec une pate diamantée.
Des clichés sont ensuite réalisés a l'aide d’un microscope optique, une source de lumiére
éclairant le verre a l'opposé de l'observation (rétroéclairage). Ce rétroéclairage fait
apparaitre les bulles contenues dans le verre. La mise au point, notamment I'ouverture,
est effectuée de telle maniére que toutes les bulles contenues dans la tranche de verre
apparaissent nettes.
Le grossissement utilisé est le grossissement le plus élevé possible permettant
I'observation de la totalité de la surface du verre de la tranche, sur une seule image.
L’image est ensuite analysée a laide du logiciel imaged, disponible sur le site
http://rsbweb.nih.gov/ij/ selon la méthode suivante :

- ouvrir 'mage dans imageJ ;

- supprimer les éventuels résultats antérieurs avec la fonction « Analyse>Clear

Results » ;
- définir la grandeur a mesurer, autrement dit la surface, en cochant uniquement la

case « Area » dans « Analyze>Set measurements », puis en validant par « OK » ;
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ajuster la luminosité avec la fonction « Image>Adjust>Brightness/contrast », puis
cliquer sur « Auto » ;

appliquer un flou gaussien « Gaussian blur » avec un sigma (ou rayon) d’une
valeur égale a 2,00 a l'aide de la fonction « Process>Filters>Gaussian blur », puis
valider a I'aide du bouton « OK » ;

Convertir le nombre de niveaux de couleurs/gris en 8 bits avec la fonction
« Image>Type>8-bit » ;

binariser I'image avec la fonction « fonction Image>Adjust>Treshold>Auto », la
case « Dark Background » étant cochée, le menu déroulant correspondant au type
de seuillage étant sur « Default », la couleur de seuillage rouge étant sélectionnée
a laide du menu déroulant sur « Red », ne pas cocher « Stack histogram »,
appuyer sur « Apply » puis fermer la fenétre ;

a laide de l'outil « Freehand » sélectionné grace a l'icéne dédiée, définir a 'aide
de la souris la zone de verre a analyser, cette zone ne contenant pas les bulles en
contact avec les surfaces intérieures du creuset ;

mesurer la surface de ladite zone, Zx, avec l'outil « Analyse>Measure ». La valeur
de la surface s’affiche dans la colonne « Area » d’'une fenétre qui s’ouvre. Noter la
valeur et fermer la fenétre ;

effacer la partie de 'image se trouvant en dehors de la zone de verre a analyser
avec l'outil « Edit>Clear outside », puis désélectionner la zone de verre a analyser
précédemment sélectionnée avec l'outil « Edit>Selection>Select None » et effacer
les résultats avec l'outil « Analyse>Clear results » ;

sélectionner a lintérieur de la zone de verre a analyser, les zones a ne pas
prendre en compte, comme par exemple les fissures pouvant apparaitre lors du
refroidissement du verre. Ces sélections s’effectuent a laide de [Ioutil
« Freehand » et son icone dédiée ;

déterminer la surface Z; de chacune des zones i & ne pas prendre en compte, de
maniere successive, a l'aide de l'enchainement de commandes suivant

« Analyse>Measure » puis « Analyse>Clear results » puis « Edit>Clear » puis
« Edit>Selection>Select None ». Répéter cet enchainement i fois. On appelle Zg la
somme des surfaces 7Z; ;

inverser les zones en noir et en blanc de [limage avec [outil
« Process>Binary>Make Binary ». Les bulles apparaissent alors de couleur noire

sur un fond blanc (valeur 255 pour le blanc, O pour le noir) ;
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certaines bulles peuvent apparaitre sous la forme de cercles non pleins (cercles
de couleur blanche avec une partie centrale de couleur noir). Pour ces bulles,
transformer la couleur noir de la partie centrale en blanc a l'aide de la fonction
« Process>Binary>Fill holes » ;

déterminer la surface des bulles a laide des commandes suivantes

« Analyze>Analyze Particles... » en indiquant dans la zone « Size » : « O-infinity »,
dans la zone « Circularity » : « 0.00-1.00 », dans la zone « Show » : « Nothing »,
puis cocher uniquement les cases : « Display results », « Clear results », « In situ
Show » et cliquer sur « OK » ;

enregistrer le fichier de résultats « Results.xls » avec la commande « File>Save
As... »;

ouvrir le fichier de résultats « Results.xls » et faire la somme Z¢ de chiffres de la
colonne « Area » représentant la surface de chaque bulle de la zone analysée ;
calculer la surface de verre observée prise en compte, égale a la surface de verre
observée Z, diminuée de la surface Zg des zones exclues, Zx-Zs;

calculer le rapport de la surface des bulles Z¢, et de la surface de verre prise en
com pte ZA-ZB, Zc/ (ZA-ZB).

Ce rapport caractérise le comportement au bullage du béton fritté au contact du verre en

fusion utilisé dans le test.

Les figures 1 et 2 représentent les surfaces de verre observées des exemples 1 hors

invention, et 3 selon linvention, respectivement. Les bulles générées par le contact du

béton fritté avec le verre en fusion apparaissent en blanc.

Le tableau 2 suivant résume les caractéristiques obtenues aprés frittage.

Exemple | Exemple | Exemple
1 3 4
ZrOz (%) 65,2 64,0 63,3
SiOz2 (%) 29,6 29,0 28,7
Cal (%) 0,71 0,69 0,69
Al2Os (%) 3,66 3,56 3,55
MgO (%) 0,05 0,52 0,77
P20s (%) 0,08 1,51 2,26
Autres oxydes (%) 0,70 0,72 0,73
% de zircon, en % massiques sur la base de la 87 97 98
masse des phases cristallisées
Masse volumique apparente (g/cm?®) 3,73 3,65 3,64
Porosité ouverte (%) 16,5 17,9 17,5
Sl_Jrface de bulles / surface de verre observée 27.9 71 9.4
prise en compte (%)

Tableau 2
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Comme le montrent les résultats indiqués dans le tableau 2, aprés contact a 1180°C
pendant 72 heures avec du verre borosilicate clair, le rapport de la surface de bulles et de
la surface de verre observée prise en compte, exprimé en pourcentage, est inférieur pour
les bétons des exemples 3 et 4 selon linvention a celui du béton de I'exemple 1 hors
invention.

Le tableau 2 montre en effet que les bétons des exemples 3 et 4 selon linvention
présente rapport de la surface de bulles et de la surface de verre observée prise en
compte égal a 7,1% et 9,4%, respectivement, trés inférieurs au rapport de la surface de
bulles et de la surface de verre observée prise en compte du béton de I'exemple 1 hors
invention, égale a 27,9%.

La quantité de défauts générés dans les articles en verre fabriqués a l'aide des bétons
frittés selon linvention est donc inférieure a celle des articles en verre fabriqués a l'aide
du béton fritté de I'exemple 1. Le rendement de fabrication des articles en verre en est
donc augmenté.

Bien entendu, la présente invention n’est pas limitée aux modes de réalisation décrits
fournis a titre d’exemples illustratifs et non limitatifs.

En particulier, les bétons selon linvention ne se limitent pas a des formes ou a des

dimensions particuliéres.
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REVENDICATIONS

1. Béton fritté ayant la composition chimique moyenne suivante, en pourcentages en

masse sur la base des oxydes et pour un total de 100% :

ZrQ; : 55 a 70%,

Si0;z : 25 3 40%,

Ca0:0,2 2 3,0%,

AlO3:0,5a7,0%,

MgQO: 0,14 3,0%,

P20s : 0,3 & 9,0%, autres oxydes : < 5,0%,
et présentant plus de 70% de zircon, en pourcentage massique sur la base de la
masse des phases cristaliisées.

2. Béton fritté selon la revendication précédente, ladite composition étant telle que :
ZrQ; > 59%, et
SiO; > 27%, &t
Ca0 > 0,4%, et
AlLOs > 1,0%, et
MgQ > 0,3%, et
Pz05 > 0,7%.

3. Béton fritté selon la revendication immédiatement précédente, ladite composition
étant telle que :

ZrO; > 61%, et

SiOz > 28%, et

Ca0 > 0,5%, et

AlQs > 1,5%, et

MgO > 0,4%, et

P20s > 1,2%.

4. Béton fritté selon lune quelconque des revendications précédentes, ladite
composition étant telle que :
ZrOz < 67%, et
SiO; < 35%, et
Ca0 < 2,0%, et
AlO; < 6,0%, et
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MgO <2,1%, et
P05 < 5,0%, et
autres oxydes < 3,5%.

5. Béton fritté selon la revendication immédiatement précédente, ladite composition
étant telle que :

ZrO2 < 65%, et

SiOz < 31%, et

Ca0 < 1,2%, et

AlO3 < 4,0%, et

MgO < 0,9%, st

P20s5 < 3,0%, et

autres oxydes < 2%.

8. Béton fritté selon I'une quelconque des revendications précédentes, dans lequel la
teneur en zircon, en pourcentage massique sur la base des phases cristallisées, est
supérieure a 80%.

7. Béton fritté selon I'une quelconque des revendications précédentes, présentant la
forme d'un bloc dont toutes les dimensions sont supérieures a 1 mm.

8. Procédé de fabrication d’un béton fritté selon I'une quelconque des revendications
précédentes, ledit procédé comprenant les étapes successives suivantes :
a) meélange de matiéres premiéres particulaires pour former une charge de
départ,
b) activation de ladite charge de départ de maniére a obtenir un béton frais,
¢) mise en forme dudit béton frais,
d) durcissement dudit béton frais de maniére a obtenir un béton durci,
e) frittage dudit béton durci de maniére & obtenir ledit béton fritté,
la charge de départ étant adaptée de maniére que ledit béton fritté soit conforme a
I'une guelconque des revendications précédentes.

9. Procédé selon la revendication immédiatement précédente, dans lequel la charge
de départ comporie
entre 1,0% et 6,0% en poids d’un liant hydraulique, et
plus de 0,256% dun phosphate de magnésium, ledit phosphate de
magnésium apportant plus de 50% du phosphore de la charge de départ.
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11.

12.

13.

14.

15.

20

Procédé selon l'une quelconque des deux revendications immédiatement

précédentes, dans lequel la charge de départ est telle que, en pourcentages

massiques sur la base de la charge de départ,

: la quantité massique de particules de zircon est supérieure a 75% et inférieure a
85%, et

- la quantité massique de particules de zircone libre est supérieure a 1,0% et
inférieure a 20,0%, et

- la quantité massique de liant hydraulique dans la charge de départ est supérieure
a 1,5% et inférieure a 5,0%, et

- la quantité massique de phosphate de magnésium, de préférence Mg(PO,). est
supérieure & 0,3% et inférieure & 14,0%.

Procédé selon la revendication immeédiatement précédente, dans lequel la charge

de départ est telle que, en pourcentages massiques sur la base de la charge de

départ,

- la quantité massique de particules de zircon est inférieure & 90%, et

- la quantité massique de particules de zircone libre est supérieure & 5,0% et
inférieure & 15,0%, et

- la quantité massique de liant hydraulique dans la charge de départ est supérieure
a 2,0% et inférieure & 4,0%, et

«~ la quantité massique de phosphate de magnésium, de préférence Mg(POs)2 est

supérieure a 1,0% et inférieure a 5,0%.

Procédé selon I'une quelconque des trois revendications immédiatement
précédentes, dans lequel le liant hydrauligue est un ciment.

Procédé selon la revendication immédiatement précédente dans lequel le ciment
est un ciment alumineux, de préférence un ciment d’aluminate(s) de calcium.

Procédé selon l'une gqueiconque des cinq revendications immédiatement
précédentes, dans lequel la teneur en alumine du liant hydraulique est comprise
entre 50% et 85%.

Procédé selon l'une quelconque des six revendications immédiatement
précédentes, dans lequel le seul phosphate présent dans la charge de départ est

Mg(POs)z.




10

15

20

16.

17.

18.

21

Procédé selon I'une quelconque des revendications précédentes, dans lequel plus
de 35% des particules de zircon présentent une taille comprise entre 150 umet 15
mm.

Unité de production de verre, comportant une pigce en un béton fritté selon I'une
quelconque des revendications 1a 7.

Unité de production de verre selon la revendication immédiatement précédente,

ladite piéce étant choisie dans le groupe formé par ;

- une brique a nez,

« unée dalle de sole,

- une piéce de superstructure,

« un bloc canal d’un canal d’'alimentation,

- un bloc brileur,

- un consommable, en particulier une chemise, un plongeur, un agitateur, un rotor,
une rondelle d'écoulement, une cuvette d’avant-corps,

- un mandrin utilisé dans une fabrication de tubes en verre selon le procédé
Danner,

- un bloc porte-électrode.
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Fig. 1

Fig. 2
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